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Limitation of Warranty and Liability (effective February 2015)
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Seller warrants the goods, excluding software sold hereunder, under normal use and
service as described in the operator's manual, shall be free from defects in workmanship
and material for twenty-four (24) months, or if less, the length of time specified in the
operator's manual, from the date of shipment to the customer. This warranty period is
inclusive of any statutory warranty. This limited warranty is subject to the following
exclusions and exceptions:

a. Hot-wire or hot-film sensors used with research anemometers, and certain other
components when indicated in specifications, are warranted for 90 days from the
date of shipment;

b.  DustTrak Environmental pump for Models 8540, 8543, 8540-M, 8542-M, and 8543-
M is warranted for two (2) years or 8760 hours, whichever comes first.

c. Parts repaired or replaced as a result of repair services are warranted to be free
from defects in workmanship and material, under normal use, for 90 days from the
date of shipment;

d.  Seller does not provide any warranty on finished goods manufactured by others or
on any fuses, batteries or other consumable materials. Only the original
manufacturer's warranty applies;

e. This warranty does not cover calibration requirements, and seller warrants only that
the instrument or product is properly calibrated at the time of its manufacture.
Instruments returned for calibration are not covered by this warranty;

f.  This warranty is VOID if the instrument is opened by anyone other than a factory
authorized service center with the one exception where requirements set forth in
the manual allow an operator to replace consumables or perform recommended
cleaning;

g. This warranty is VOID if the product has been misused, neglected, subjected to
accidental or intentional damage, or is not properly installed, maintained, or cleaned
according to the requirements of the manual. Unless specifically authorized in a
separate writing by Seller, Seller makes no warranty with respect to, and shall have
no liability in connection with, goods which are incorporated into other products or
equipment, or which are modified by any person other than Seller.

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS
stated herein. NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR
PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE. WITH RESPECT TO
SELLER’S BREACH OF THE IMPLIED WARRANTY AGAINST INFRINGEMENT, SAID
WARRANTY IS LIMITED TO CLAIMS OF DIRECT INFRINGEMENT AND EXCLUDES
CLAIMS OF CONTRIBUTORY OR INDUCED INFRINGEMENTS. BUYER’S
EXCLUSIVE REMEDY SHALL BE THE RETURN OF THE PURCHASE PRICE
DISCOUNTED FOR REASONABLE WEAR AND TEAR OR AT SELLER’S OPTION
REPLACEMENT OF THE GOODS WITH NON-INFRINGING GOODS.

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR
BUYER, AND THE LIMIT OF SELLER'S LIABILITY FOR ANY AND ALL LOSSES,
INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED
ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL
BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE
PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE
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GOODS. IN THE CASE OF SOFTWARE, SELLER WILL REPAIR OR REPLACE
DEFECTIVE SOFTWARE OR IF UNABLE TO DO SO, WILL REFUND THE PURCHASE
PRICE OF THE SOFTWARE. IN NO EVENT SHALL SELLER BE LIABLE FOR LOST
PROFITS, BUSINESS INTERRUPTION OR ANY SPECIAL, INDIRECT,
CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE
RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS
OR CHARGES. No Action, regardless of form, may be brought against Seller more than
12 months after a cause of action has accrued. The goods returned under warranty to
Seller's factory shall be at Buyer's risk of loss, and will be returned, if at all, at Seller's risk
of loss.

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY AND
LIABILITY, which contains the complete and exclusive limited warranty of Seller. This
LIMITATION OF WARRANTY AND LIABILITY may not be amended, modified or its terms
waived, except by writing signed by an Officer of Seller.

Service Policy

Knowing that inoperative or defective instruments are as detrimental to TSI as they are
to our customers, our service policy is designed to give prompt attention to any
problems. If any malfunction is discovered, please contact your nearest sales office or
representative, or call TSI's Customer Service department at (800) 680-1220 (USA) or
(001 651) 490-2860 (International) or visit www.tsi.com.
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Safety Information

Laser Safety

e Models 8540/8543/8540-M/8542-M/8543-M DustTrak™
Environmental Monitors are Class | laser-based instruments.

e During normal operation, you WILL NOT be exposed to
laser radiation.

e Precaution should be taken to avoid exposure to hazardous
radiation in the form of intense, focused, visible light.

e Exposure to this light may cause blindness.

Take these precautions:

e DO NOT remove any parts from the DustTrak™ Environmental
Monitor unless you are specifically told to do so in this manual.

WARNING

The use of controls, adjustments, or procedures other
than those specified in this manual may result in
exposure to hazardous optical radiation.

WARNING

If the DustTrak™ monitor is used in a manner not
specified by the manufacturer, the protection
provided by the equipment may be impaired.

When operated according to the manufacturer’s instructions, this
device is a Class | laser product as defined by U.S. Department of
Health and Human Services standards under the Radiation Control
for Health and Safety Act of 1968. A certification and identification
label like the one shown below is affixed to each instrument.



Labels
Advisory labels and identification labels are attached to the instrument.

1. Serial Number Label (back) DUSTTRAK™ DRX — Model 8543

vy || TR
CLASS | LASER PRODUC

MFD APRIL 2015
T
COMPLIES WITH 21 CFR 104010 AND 1040.11

B, ) (€
Shoreien. i 35128 ) = 12124V =50

Wingige Made in USA
2. Laser Radiation Label DANGER!
(internal) VISIBLE LASER RADIATION WHEN
OPEN. AVOID DIRECT EXPOSURE
TO BEAM

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING
TO QUALIFIED PERSONNEL

3. Calibration Label (back) ® Calibrated

Customer Service 1-800-874-2811
Outside US 001-651-490-2811
www.tsi.com
Date: January 2021

4. |IP Label (back) USB IP Address:
199.254.130.225

5. European symbol for non-
disposable item. Item must
be recycled.

6. MCERTS Certification Label(s)

THE ENVIRONMENT AGENCY'S THE_ENVIRONMENT AGENCY'S THE ENVIRONMENT AGENCY'S

MONITORING CERTIFICATION SCHEME MONITORING CERTIFICATION SCHEME MONITORING CERTIFICATION SCHEME

Sira MC160316/XX Sira MC160317/XX Sira MC160318/XX
854201-M1 854001-M1 854301-M1

vi
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Description of Caution/Warning Symbols

Appropriate caution/warning statements are used throughout the
manual and on the instrument that require you to take cautionary
measures when working with the instrument.

Caution

>

Warning

>

CAUTION

Failure to follow the procedures prescribed in this
manual might result in irreparable equipment
damage. Important information about the operation
and maintenance of this instrument is included in
this manual.

WARNING

Warning means that unsafe use of the instrument
could result in serious injury to you or cause damage
to the instrument. Follow the procedures prescribed.

Caution and Warning Symbols

The following symbols may accompany cautions and warnings to
indicate the nature and consequences of hazards:

Warns that the instrument contains a laser and that
important information about its safe operation and
maintenance is included in the manual.

Warns that the instrument is susceptible to electro-
static discharge (ESD) and ESD protection should be
followed to avoid damage.

® b~

Indicates the connector is connected to earth ground
and cabinet ground.

Vii




Reusing and Recycling

As part of TSI® Incorporated’s effort to have a
minimal negative impact on the communities in which
its products are manufactured and used:

@® DO NOT dispose of used batteries in the trash.

Follow local environmental requirements for
battery recycling.

® If instrument becomes obsolete, return to TSI® for
disassembly and recycling.

viii



Chapter 1

Product Overview

DustTrak™ Environmental Models 8540, 8540-M, and 8542-M and
DustTrak™ DRX Environmental Models 8543 and 8543-M Monitors
are data-logging, light-scattering laser photometers that provide real-
time mass concentration readings for aerosol contaminants such as
dust, smoke, fumes and mist. These instruments use a sheath air
system that isolates the aerosol in the optics chamber to keep the
optics clean for improved reliability and low maintenance. These
monitors offer a suitable solution for long-term outdoor monitoring,
construction and environmental clean-up sites.

DustTrak™ Environmental Monitors (Model 8540,
8540-M, and 8542-M)

The DustTrak™ Environmental Monitors are continuous, real-time,
single-channel, 90° light-scattering laser photometers that are used to
determine the mass concentration of aerosols. A robust, long-life
pump allows for the use of a variety of size-selective inlet conditioners
to measure aerosol concentrations corresponding to PMio, or PMzs.

DustTrak™ DRX Environmental Monitors (Model 8543
and 8543-M)

The DustTrak™ DRX Environmental Monitors are continuous, real-
time light-scattering laser photometers that simultaneously measure
size-segregated mass fraction concentrations corresponding to PMz,
PMzs, and PMio—something no other monitor can do. The instrument
combines both particle cloud (total area of scattered light) and single
particle detection to achieve mass fraction measurements. This size-
segregated mass fraction measurement technique is superior to either
a basic photometer or optical particle counter (OPC). It delivers the
mass concentration of a photometer and the size resolution of

an OPC.

The DustTrak™ Environmental Monitors are designed to operate
inside the TSI® Environmental Enclosure (Model 854038) which has
an International Protection Marking of IP44. The DustTrak™
Environmental Monitor should not be used outdoors without an
appropriate weather-proof enclosure.



Models 8540-M, 8542-M, and 8543-M MCERTS
Certified Monitors

DustTrak™ Environmental Monitor Models 854201-M1, 854001-M1 or
854301-M1, have been designed to meet the UK’'s MCERTS
(Monitoring Certification Scheme) for indicative instruments. The
following must be installed for these models to meet the
MCERTS Indicative Certification:

854201-M1: MCERTS PM10 Indicative Certification

Q 8542-M Photometer V
854038 Environmental Enclosure \/‘

- b

U 854020 PM10 Impactor MCERTS
O 854041 Heated Inlet
a

PCF set at 0.53 (preset at the factory). It is recommended that the
instrument is run with a Photometric Correction Factor (PCF) of
0.53. However, the application of a site specific correction factor
may be used if a significant decrease in the expanded uncertainty
can be demonstrated.

854001-M1: MCERTS PM2.5 Indicative Certification
O 8540-M Photometer \/
854038 Environmental Enclosure .\/‘

854021 PM2.5 Impactor MCERTS

nnnnnnnnnnnnnnnnnnn s

MONITORING CERTIFICATION SCHEME

854041 Heated Inlet Sira MC160317/XX

O 000

PCF set at 0.33 (preset at the factory). It is recommended that the
instrument is run with a Photometric Correction Factor (PCF) of
0.33. However, the application of a site specific correction factor
may be used if a significant decrease in the expanded uncertainty
can be demonstrated.
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854301-M1: MCERTS PM10 and PM2.5 Indicative Certification
O 8543-M Photometer

854038 Environmental Enclosure %

a

0 854041 Heated Inlet 71CERTS

U PCF PM2.5 set at 0.47, PM10 set at 0.53 (preset Sira MC160318/XX
at the factory). It is recommended that the
instrument is run with a Photometric Correction Factor (PCF) of
0.53. However, the application of a site specific correction factor
may be used if a significant decrease in the expanded uncertainty
can be demonstrated.
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Unpacking and Parts ldentification

Carefully unpack the Model 8540 /8540-M/8542-M /8543 /8543-M
DustTrak™ Environmental Monitor from the shipping container. Use
the tables and illustrations below to make certain that there are no
missing components. Contact TSI® immediately if anything is missing

or damaged.

Unpacking the DustTrak™ Monitor

Compare all the components you received with those listed in the
table below. If any parts are missing, contact TSI®.

Item Qty | Part Number | Description
: i 1 8540 DustTrak™
‘I 8540-M Environmental
".“?2“ ® ; 8542-M Monitor
‘ l 8543 DustTrak™ DRX
» 8543-M Environmental
. Monitor
1 1090014 Data Analysis
Software CD-ROM
& 1 1303740 USB cable
e
=
~a
~
1 854052 12 VDC power

supply




Item Qty | Part Number | Description

1 6008408 Operation and
Service Manual

# )
g 1 N/A Calibration
g Certificate

User Replaceable Internal Parts
Item ‘ Part Number ‘ Description
854044 Sheath Air Filter

854043 Pump

NA 37-mm, 2-piece,
static conductive
cassette

Blank replacement cassettes or media can be ordered from
www.zefon.com.
37-mm 2-piece blank cassette product # 37MMH-2-CF

Zefon can also supply pre-weighed filter media for gravimetric sampling.

6 Chapter 2
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Optional Accessories

ltem

%‘
4

-
Ly sy

t

Part Number
854038

Description

Environmental
Enclosure

801905

Netronix™
Thiamis™ 1000
Communication
Node

854040

Omni-directional
Inlet w/Water Trap
Bottle

e
y,

s

=
L ,
& &/

854041

Heated Inlet
Sample Conditioner

Unpacking and Parts Identification




Part Number | Description

854039 Enclosure Power

Supply

‘ ™ 854042 Water Trap Bottle
{

K o) 854020 PMio Impactor

-»
=2 a2t 854021 PMz2s Impactor
‘ 854022 PMa.0 Impactor

Parts Identification for the DustTrak™ Environmental
Models 8540/8540-M /8542-M /8543 /8543-M

r\ Inlet

<+—— Analog/Alarm

<+—— USB Host
<+—— USB Device

Ethernet
Power Power and
Button RS-232
Communication
for Heated Inlet
Service Accessory
Panel Power

Figure 1: Features on Models 8540/8540-M/8542-M/8543/8543-M
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Figure 2: Back panel interface control dimensions

Figure 3: View of back panel with mounting holes shown

Holes are pre-drilled in the back of the photometer to enable users to
develop their own mounting bracket for attaching the photometer into
an alternate enclosure.

Mounting the photometer using these holes will need quantity four (4)

#6-32 screws that penetrate no deeper than 0.230” into the back
panel of the photometer.

Unpacking and Parts Identification 9



Chapter 3

Setting Up

Environmental Enclosure

The DustTrak™
Environmental Monitor
is designed to be
mounted inside in the
environmental
enclosure. TSI® part
number 854038
Environmental
Enclosure has been
designed specifically to
protect the DustTrak™
Environmental Monitor
and its accessories.
See Environmental | S
Enclosure Model

854038 Operation and f

Maintenance Manual

(P/N 6012377) for .
more details and ..
installation instructions. @

Figure 4: Environmental Enclosure
(as shown with optional accessories
Omni-directional inlet and solar shield)

11



Supplying Power to the DustTrak™ Environmental
Monitor

One method for supplying power to the instrument is to use the 12V
power supply (TSI® P/N 854052). Fasten the barrel connector to the
instrument as shown in Figure 5. This power supply comes with a
region-specific power cord and is mainly used to power the instrument
when it is not mounted inside of the enclosure and communication is
required for diagnostics and programming.

® 4
[

Figure 5: Instrument power connection

If the instrument is installed into the 854038 Environmental
Enclosure, power options include AC Power Supply (854039), AC
power supply included with enclosure heater (854054), Rechargeable
Battery Power System (854036), and Solar Power System (854060).

12 Chapter 3



Omni-directional Inlet Column

Optional accessory 854040

See the Quick Start Guide installing impactors PMio (854020), PM2.s
(854021), PM1 (854022) onto the omni-directional inlet for details.

Figure 6: Inlet, water trap and base with connection rings

Zero Calibration of Instrument

The DustTrak™ Environmental Monitor has the ability to automatically
“Zero” the instrument readings at programmed intervals. “Zeroing” the
instrument resets the photo detector, to a signal that represents no
particles flowing through the optics. Over time, photometric light-
scattering instrument readings can drift due to changes in temperature
and aerosol build up in the optics. Programming regular “Zero” events
corrects the photometric signal to account for these changes.

The DustTrak™ Environmental Monitor automatically performs a zero
calibration when the instrument begins any programmed run and the
auto zero function has been enabled. Use the instructions detailed in
Chapter 4 for enabling auto zero and configuring the automatic
interval using the TrakPro™ software.

Setting Up 13



Instrument Setup and Operation Options
1

‘*‘ B 2®

7

ICERTs

2 =
- - e

Power button .
)

e )
\

Figure 7: Setting up instrument and operating options

Press the power button to turn on instrument. The button will turn
blue, indicating the instrument has power and is turned on.

To turn instrument off, hold the power button for 10 seconds and then
release. The blue indicator light in the power button will turn off,
indicating the instrument has shut down.

Use the DustTrak™ Checkout Software or Netronix™ Environet (both
explained below) to read the instrument status, program instrument,
and activate instrument programmed runs.

The DustTrak™ instrument can be setup and controlled using one of
three options:

e Use TrakPro™ Data Analysis Software to configure instrument,
run instrument and download data. Quick start information for
using TrakPro™ software is shown in the section below.

e Use a Netronix™ Thiamis™ Communication Node and web-
based application Environet to setup and control the DustTrak™
monitor remotely. See Netronix™ quick start guides for
Netronix™ installation and set-up.

e Use the DustTrak™ monitor's command set to develop a custom
program for setting up and controlling the DustTrak™ monitor.
See the command set information in Appendix B.

14 Chapter 3
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DustTrak™ Checkout Application

e DustTrak™ Checkout Application enables a “virtual screen” for
the DustTrak™ monitor. Instrument data, flow calibration, zero
calibration, instrument diagnostics, etc., can be viewed or
performed through the use of the checkout software.

e This software can be used as part of your field installation
process to ensure the instrument is functioning properly, when
Netronix™ is not being used or a web accessed device is not
immediately available during field installation.

Open DustTrak™ Checkout executable file and follow the steps to run
the installation wizard.

e The DustTrak™ Checkout Application can also be
downloaded from the TSI® website. Visit
http://www.tsi.com/Software-Firmware/ and click on the
Software and Firmware Wizard link. Follow the on-screen
instructions to download the software.

e Your computer must have the current version of
TrakPro™ software to access the proper drivers to
communicate with this Checkout Application.

Name Date modified Type Size

‘a‘ EnvDTCheckoutInstall.exe 2/11/2015 12:41 PM  Application 4,038 KB

15 EnDTCheckoutinstal - mwnm

Welcome to the InstallShield Wizard for |
EnvDTCheckoutInstall

Do you want to allow the following program to make

changes to this computer?

.a Program name:  EnvDTCheckoutlnstall
Verified publisher: TS, Incorporated
File origin: Network drive

V Show details Yes

Change when these notifications appear

Figure 8: Checkout Application — Setup screen

Setting Up 15
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DustTrak™ Checkout Application

After installing the application, plug the provided USB cable into
the “USB B” port on the instrument and plug the other end into
your computer. Power on the instrument and click the Connect
button. The USB IP address and instrument information will appear
when connected.

» Environmental DustTrak Checkout  1.0.0.]

Connect | Data | Flow | Zero | Laser | Diagnostics | IP Label

Serial Number: 8543150403
Model Number: 8543
Firmware Version: 3.3
Instrument Time: 4/15/2015 6:40:9 [ Set Instrument Date and Time ]
Calibration Date: 1/30/2015
Filter Change Date: 1/30/2015
Cum Mass Conc: 0.314178 Reset Filter Date and Concentrations
Cum Filter Conc: 0

Pump Run Time: 0

Shutdown Instrument

Figure 9: Checkout Application — Connect tab

Click the Data tab to access the current instrument readings.

Clicking the green arrow will start the instrument pump to begin
sampling in Survey Mode. No data will be logged onto the

instruments m

emory while running in Survey Mode.

T e o ==
| Connect ‘ Data | Flow | Zero ‘ Laser | Diagnostics | IP Label

Average # reading per second Current Run Mode:  SURVEY

1 |

o

PML 0000 . e

PM2.5:  0.000

PM4: 0.000 . Laser

PM10:  0.000

Total:  0.000 . Filter

16

Figure 10: Checkout Application — Data tab

Chapter 3



Click on the Flow tab to adjust the pump flow rate.

+&) Environmental DustTrak Checkout  2.0.0.0 ==

Connect | Data | Flow ‘ Zero ‘ Laser ‘ Diagnostics | IP Label | IP Addressing

Start flow then Adjust flow to the desired value.

When done click Save to store the new value.

@‘ Actual Flow (LPM) Save |

Adjust Flow

v

Flow 1.00

Figure 11: Checkout Application — Flow tab

Click the green arrow to start the pump, allowing for a change to the
flow setpoint. The flow setpoint is factory set to 3 L/min total flow.

2 L/min of the total flow is measured aerosol flow. 1 L/min of total flow
is split off, filtered, and used for sheath flow. There is an internal AP
flow meter in the DustTrak™ instrument that controls flow rate to +5%
of the factory setpoint. TSI® recommends checking the flows with an
external flow reference meter, especially when collecting data.

1. Attach a flow calibrator (reference flow meter) to inlet port. You
may use a bubble buret, mass flow meter, dry piston or rotameter
as flow measurement devices.

2. Click on the up or down arrows to achieve desired flow on the
reference flow meter. Each click of the up or down arrow will
change the flow about 1%. Allow time between button presses to
let pump change to the new flow rate.

3. Click Save once the desired flow rate is achieved. Select Undo to
return to the factory setpoint.

NOTE — Models 8540, 8540-M, 8542-M

The flow rate can be adjusted from approximately 1.5 to
4.0 L/min. If needed, this feature can be used to adjust the
flow rate to a value other than the factory setpoint, allowing
for the use with 3™ party size selective inlets (cyclones or
impactors) that may require a different flow rate.

Setting Up 17



NOTE — Models 8543, 8543-M |

The flow rate can be adjusted from approximately 1.5 to
4.0 L/min. This feature allows you to re-adjust the flow rate,
if needed, to 3.0 L/min. The flow rate for the DRX models
should remain fixed at 3.0 L/min. No size-selective inlets or
cyclones should be installed on the inlet of the instrument
during its normal operation.

Click on the Zero tab to manually perform a zero calibration for the
instrument. Click Start Zero to start the zeroing process.

The “Last Zero” and “New Zero” values do not represent particle
count or aerosol mass. These values are associated with the signal
received by the photometric sensor when no particles are passing
through the optics.

— ———— M
+8 Environmental DustTrak Checkout 1.0.0__- N ) e

Zero ‘ Laser | Diagnostics ‘ IP Label ‘

Attach the Zero filter then click the Start Zero button below.

Start Zero
I

HConnect Data | Flow

Last Zero: 1831 New Zero: 1832 |

Figure 12: Checkout Application — Zero tab

The Laser tab is only accessible in password-protected

“Engineering Mode.” Changes made to the Laser setting will directly
affect the calibration, the instrument response, and is available only to
TSI® technicians.
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The Diagnostics tab opens a command window that can be used to
send instructions to the instrument. Click Send or press the Enter key
to send the command to the instrument. See the Communication
Settings in Appendix B.

-
i

Zero | Laser = Diagnostics iIPLabeI
Command:  [RMMEAS

Response

Connect | Data | Flow

Figure 13: Checkout Application — Diagnostics tab

The IP Label tab opens a printer connection box and displays the
instrument IP address.

_

Connect | Data | Flow

Zero | Laser | Diagnostics | [P Label

Printer Connection: COM1

Inst IP addr: 169 254 217 77

Figure 14: Checkout Application — IP Label tab

Setting Up 19



The IP Addressing tab can be used to change the settings for the
instruments Ethernet IP address. After making changes, click Save
for the settings to take effect.

& Environmental DustTrak Checkout  2.0.0.0 (o= =]

Zero ‘ Laser ‘ Diagnostics | IP Label ‘ IP Addressing

Flow

Connect | Data

EThernet IP Addressing Static ~

Current IP Address 192 168 . 8 186
Current Subnet Mask 255,255 255 . 0
Current Gateway 192 168 8 . 2

Figure 15: Checkout Application — IP Addressing
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Chapter 4

TrakPro™ Software Quick Reference

Connecting to the Computer

The TrakPro™ software can be used to preprogram the instrument,
download data, view and create raw data and statistical reports,
create graphs, and combine graphs with data from other TSI®
instruments that use TrakPro™ software. Connect the USB host port
of a Microsoft® Windows®-based computer to the USB device port on
the side of the DustTrak™ monitor.

Installing TrakPro™ Data Analysis Software

The following sections describe how to install the software and set up
the computer.

To use TrakPro™ software with the DustTrak™ Monitor,
the PC must be running Microsoft® Windows® and the
computer must have an available Universal Serial Bus
(USB) port.

1. Insert the TrakPro™ Data Analysis Software CD into the
CD-ROM drive. The install screen starts automatically.

If the software does not start automatically after a few
minutes, manually run the program listed on the label of the
CD using the Run command on the Windows® Start Menu.

2. Follow the directions to install TrakPro™ software.

TrakPro™ software contains a comprehensive installation guide.
TSI® recommends printing out this guide prior to starting the
TrakPro™ software installation on your computer, so it may be
consulted during the installation. The TrakPro™ software manual is
located in the “Help” file in TrakPro™ software. There is no
separately printed TrakPro™ Data Analysis software manual.

®Microsoft and Windows are registered trademarks of Microsoft Corporation.
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TrakPro™ Software Steps

Establishing Communications with the Instrument

Open up TrakPro™ software and Instrument Setup | Options  He
select Instrument Setup -> | Communications... b

Communications. = Radic Cormm... B

Parameters 4
Logging Setup...
Legging Control

Calibration...

The software will NDIS Communications .
automatically find the

instrument, as shown in

DustTrak DR detected witk 1P 169254241173

Serial Murmber | 8543150403

Status |Communicati-:-ns Functioning OF,

IPAddiess 163 . 254 . 241 . 173

Configuring the Logging Parameters
Select Instrument Setup ->

Logging Setup Instrument Setup | Options He
Communications... W

Radic Comm...

Parameters L4

Logging Setup...

Lagging Contral

Calibration...
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This will open a dialog allowing for the configuration of the different
instrument run modes. The sampling mode options include Survey
mode, Manual Mode and Program Logs 1-5.

Survey

Survey Mode runs a real time, continuous active
sample, but does not log data.

Manual

Manual Log sets the instrument to log data for a
specified run time.

Log Modes

Log Mode starts and stops the instrument at
specified times, run for a specified test length, and
perform multiple tests of the same length with a
specified time period between tests.

Logging Program Setup

S

Serial Mumber:

Select protocal to edit

8543150403 Wumber Tests Logged: 1 Auwailable Memary %: 100

Program

SURVEY |?|

01/07/2008 |W|

Name

Start Date (M7 dd )

Start Time [hk:mm]: 00:00 =

| Clear Entry |

Lag Interval [mm:ss]: =

| Clear Program |

Test Length [dd:hh:mm]:

Humber of Tests:

Cloge

Time Between Tests [dd:hh:mm]:

A4

Time Constant:
Auto Zem Enable and Interval [hh:mm]:

Percent Total Memory Required: 100

Press the Read button to get the current log modes
from the instrument.

Update the log modes to meet logging requirements. Details on log
modes are in table below.

Survey Mode Options

Time Constant

Time Constant can be set from 1 to 60 seconds.

Auto Start on

When set to “Yes”, unit will start a measureme

nt

Power Up upon being powered on, if the unit was set to
“Survey” when it was turned off.
When set to “No”, the unit will be in idle when it
is powered on.
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Manual Mode Options

Log Interval The log interval can be set from 1 second to
60 minutes. It is the amount of time between
logged data points.

Test Length Test length can be set from 1 minute to the
limit of the data storage.
Time Constant Not used for the 8540/8540-M /8542-M/

8543/8543-M models.

Program Log Options

Log Name Enter descriptive name for the log mode.

Start Date Select the date and the test will start.

Select the check box to use Start Date,
option to use programmed start date, or
bypass programmed start date.

Start Time Select the time the test will start.

Select the check box to use Start Time,
option to use programmed start time or
bypass programmed start time.

Log Interval The log interval can be set from 1 second to
60 minutes. It is the amount of time between
logged data points.

Test Length From 1 minute to the limit of the data storage.

Number of Tests 1 to 999.

Time between 1 minute to 30 days.

Tests

Time Constant Not used for the 8540/8540-M /8542-M/
8543/8543-M models.

Auto Zero Interval Interval between re-zeroing the instrument

using the built in autozero functionality.

Use the check box to enable use of
autozeroings.

Once the log modes have been updated, press m eenn |
Send
the Send button to send the new log modes to _

the instrument.
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If using a programmed start time and start date, update the
instrument date and time to ensure the logging starts as planned.

Select Instrument Setup -> Parameters -> Clock to set the time.

Instrument Setup
Communications,..

Radic Comm...

Options  Help

ust Trake DRX

Parameters

Clock...

Legging Setup...

Legging Intervals...

Legging Control Time Constants...

o Other...
Calibration...
Analog Output...
Alarm Setpoint...
Clock Setup @
Enter date as ™MM/dd/yyyy tme as hh:mm:ss
or transfer System Time
System Time Instrument Time
01/24/2015 > 01242015 @~ send
13:52:33 2 06:34:08
| I

Setting User Calibration Factors

In most cases, a user calibration factor of 1 for photometric and size
cal (DRX only) will be sufficient. Use the following instructions to
change the instruments User Cal, if an improved calibration factor
is required.

Set User Calibration Factor allows you to store and use 10 different
calibration factors. In addition, there are preprogrammed factory
defaults, one is the “Ambient Cal” and the other is the “Factory Cal”
(8540-M, 8542-M and 8543-M also have an MCERTS cal). The
“Ambient Cal” is appropriate for outdoor ambient dust or fugitive dust
monitoring. The “Factory Cal” is the calibration to ISO 12103-1, Al
Arizona test dust for which a calibration certificate is provided with the
instrument. The “Factory Cal” is appropriate for most workplace
aerosol monitoring. Factory Cal can be set by simply setting both the
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size correction factor (DRX model only) and the photometric

calibration factor to 1.

Use the following steps to get to
the user cal functionality:

Select Instrument Setup ->
Calibration.

Instrument Setup | Options  He

Communications... 1

Radio Comm...

Parameters 4
Logging Setup...
Logging Control

LCalibration...

Click the Set User Calibration Factor button to access the

instrument calibration settings.

Uzer Calibration
Sensor Last Calibrated
COzZ
CO:
Temperature:
Hurnidity:
AL

Aerogal;

Factary Calibratian

Calibration Date:

0143042015
0143042016

In this dialog, you can select the factory ambient cal or customizable
user cals 1 through 10, (1 through 9 for MCERTS models 8540-M,

26
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8542-M and 8543-M). User Cals 1 through 10 can be used to set
custom user calibration factors.

[ 5
Instrument Calibration @

User Calibration Mame:
picers) B

Usger Cal 1 Name:

User Cal 2

User Cal 3 MCERTS
User Cal 4

User Cal 5 Photometric:
User Cal 6

User Cal 7 0.530
User Cal 8

Usger Cal 3

Ambient

User Cal [On, Off]:

@ oN ©) OFF

b

Four variables can be set for each user calibration.

Name User can input a custom description for the
custom User Calibration.

Photometric Changes the factory calibration of particle

Calibration signal, based on Arizona Road Dust, to actual

Factor aerosol being measured.

Size Calibration | Changes the factory calibration of the
Factor particle distribution, based on Arizona Road
Dust, to actual aerosol being measured. This
is for the DRX only. A setting of 1 works for
most situations.

User Cal [on,off] | Selecting On will activate current user
calibration and deactivate the previously
selected user calibration.
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Determining a new Photometric Calibration Factor

In most situations, the DustTrak™ monitor with its built-in data logging
capability can provide very good information on how the

concentration of an aerosol changes for different processes over
time. Factory calibration to the respirable fraction of standard

ISO 12103-1, Al test dust is fairly representative of a wide variety of
workplace aerosols. Because optical mass measurements are
dependent upon particle size and material properties, there may be
times in which a custom calibration would improve your accuracy for a
specific aerosol.

Determining an aerosol-specific photometric calibration requires that
you determine a true mass concentration (e.g., gravimetric analysis)
for the aerosol you want to measure. The true mass concentration is
used to calculate the custom calibration factor for that aerosol. Once
you have a custom calibration factor, you can reuse it each time you
make measurements in the same aerosol environment.

Determining the Calibration Factor for a Specific Aerosol

The DustTrak™ monitor is factory calibrated to the respirable fraction
of standard 1ISO 12103-1, Al test dust. The DustTrak™ monitor can
be easily calibrated to any arbitrary aerosol by adjusting the custom
calibration factor. The DustTrak™ monitor’s custom calibration factor
is assigned the value of 1.00 for the factory calibration to standard
ISO test dust. This procedure describes how to determine the
calibration factor for a specific aerosol. Using the value of 1.00 will
always revert back to the factory calibration.

To determine a new calibration factor you need some way of
accurately measuring the concentration of aerosol, hereafter referred
to as the reference instrument. A gravimetric analysis is often the best
choice, though it is limited to nonvolatile aerosols.

To make an accurate calibration you must simultaneously measure
the aerosol concentration with the DustTrak™ monitor and your
reference instrument.

1. Zero the DustTrak™ monitor.

2. Putthe instrument in Manual Log (Manual Logging is reviewed
later in this section).

3. Set the logging interval. One minute (i.e., “01:00”) is often a
good choice.
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4. Co-locate the DustTrak™ monitor and the reference sampler
together so that they are measuring from the same area.

5. Start sampling aerosol with both instruments at the same time.

Greater accuracy will be obtained with longer samples. The
time you permit for sampling often depends on the
reference instrument and characteristics of the measured
aerosol. It may take some time to collect sufficient aerosol
onto a filter cassette for accurate gravimetric analysis.
Refer to instructions of your reference instrument for
sampling times.

6. Stop sampling with both instruments at the same time.

7. Record the DustTrak™ monitor average concentration by viewing
the sample average by downloading the saved data to
TrakPro™ software.

8. Determine the mass concentration in mg/m?® from your reference
instrument. For gravimetric sampling this means weighing the
gravimetric sample.

NOTES

o If you installed a gravimetric filter into the DustTrak™
monitor and are; therefore, using the DustTrak™ monitor
to obtain a gravimetric sample, the flow rate used to
compute the concentration should be 2 L/min, not 3 L/min
since only 2 L/min of aerosol flow reaches the filter.

e To ensure proper fit into the DustTrak™ gravimetric holder,
TSI® recommends using conductive, polypropylene,
2-piece 37-mm cassette housings.

9. Compute the new calibration constant, NewCal, using the
following formula:

Reference Concentration
DustTrak Concentration

NewCal= ( ) -CurrentCal

10. Enter the new value into one of User Cal [On, Off]:
the custom user cals and turn that
cal “on” using the radio button. @ ON OFF
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Starting a DustTrak™ Sample Run

Once a log mode is set and a calibration mode selected, the
DustTrak™ monitor can be started using TrakPro™ software. To start
a sample, perform the following steps.

First select Logging Control Instrument Setup | Options  H

Select Instrument Setup -> Communications... )

Logging Control.

Next, establish
communication
with the
instrument

Press the
Discover
Instrument
button.

30

Radio Comm...

Parameters 4

Logging Setup...

Logging Control |

Calibration...

e =

DustTrak DR detected on 169.254.241.173
Communications Functioning 0K

Model Number 3543 Serial Number 8543150403

Instrument Status |Id|e

IP Address 189 . 254 . 241 . 173
Discover Instrument
Logging Program - Start Logging
Stop Logging
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Select your
desired log mode
from the Logging
Program drop-
down menu.

oo

DustTrak DR detected on 169.254.241.173
Communications Functioning 0K

Model Number (8543 Serial Number 3543150403

Instrument Status |Id|e

IP Address 169 . 254 . 241 . 173

Discover Instrument

Logging Program | L1==18E Start Logging
Stop Logging

Press Start
Logging to begin
the |Ogg|ng Inztrument logging started

Model Number (8543 Serial Number 3543150403

Instrument Status |F| unning

IP Address 169 . 254 . 241 . 173

Discover Instrument

Logging Program ~ TEST 3
Stop Logging

Close

If a start date and start time is selected, the instrument will
not immediately start with the logging and will remain in idle
unit the targeted date and time.
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Downloading Data
Once the data has been logged to File| Graph

the instrument, it can be down
loaded into TrakPro™ software.

Select File->Receive to download
data from the instrument.

This will allow for
the downloading
of some or all of
the data stored on
the insturment.

Reports  Wiew |

Percent Log Memary Available: 100

= Open... Ctrl+0  §
E[ Close Ctrl+M 1
EH save Ctrl+5 |
Save As...
|EE. Beceive... Ctrl+R ‘
Export b
| Delete Test
r Receive Tests From Instrument &Jj
Instrument:  |DustTrak DR Serial Mumber: 3543150403
Select Logged Data Test|s] to Receive: [2]
ID Date  Time
TESTS 002 Ounarns ans
. .
,

Viewing, Graphing and Exporting Data

Read the TrakPro™ software help files for information on how to
view, graph and export the DustTrak™ data.
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Local Analog/Alarm Output

The DustTrak™ Environmental Monitor has an Analog/Alarm Output
connection on the side of the instrument.

The pin-outs for wiring are shown below.

Analog Output (+) Alarm Positive (+)

Analog Ground (=)

Alarm Ground (-)

4-pin miniDIN connector

Cable Wiring Diagram \

Brown Wire Analog Ground
Orange Wire Analog Out
Red Wire Alarm (+)
White Wire Alarm (-)

Black Wire Shield

Figure 16: Cable Wiring Diagram

Wiring the Analog Output
System specifications:

e Output voltage: 0 to 5 VDC. With a maximum output of 15 mA.

e Output Current 4 mA to 20 mA with a maximum load impendence
of 250 ohms.

e Correct polarity must be observed (see pin-outs above).
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Wiring the Alarm

System specifications:

e Maximum voltage: 15 VDC (DO NOT USE AC POWER)

¢ Maximum current: 1 Amp

e Correct polarity must be observed (see pin-outs above)
e The alarm switch, located inside the DustTrak™ monitor must be

located on the ground side of the alarm system.

WARNING

The Alarm Output function SHOULD NOT be used
to detect hazardous conditions or to provide an
alarm for protecting human life, health, or safety.

When connected to the analog out and alarm out
connector, you MUST use safety certified

equipment and/or power sources.

CAUTION

The alarm switch MUST NOT be wired to AC power!
Failure to install the user alarm properly could
damage the DustTrak™ instrument and/or void the
instrument warranty! Please read and follow all
instructions before wiring or operating the user alarm.

Using TrakPro™ Software to Program the Analog Output

Use TrakPro™ software to configure the Analog output. Select
Instrument Setup -> Parameters -> Analog Output... to get to the

Analog output dialog.

Instrument Setup

Communications...

Radio Comm...

QOptions

Help
Bust Trak DRX

Parameters

Clock...

Legging Setup...
Logging Control

Calibration...

Logging Intervals...
Time Constants...

Other...

| Analog Output...

8533104202

QRO
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This dialog will allow for the turning on/off and configuring of the

analog output.

Analog Cut Settings

Size Fraction PM1

- 1
Analog Out @
an Send
@ OFF

Qutput Setting 0-5Y

Upper Limit [mg,m3]
0.000
Lower Limit [mgym?]

Analog out [On, Off]

Turns analog out port on.

Size Fraction

Selects the size channel that will drive
the analog out. DRX Models 8543 or
8543-M only.

Output Setting [V, mA]

Select 0-5 V or 4-20 mA.

Lower Limit [mg/m?3]

Mass concentration reading of the
selected channel that will correspond
to 0V or 4 mA.

Upper Limit [mg/m?3]

Mass concentration reading of the
selected channel that will correspond
to 5V or 20 mA.
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Using TrakPro™ Software to Program Alarm Setpoints
Use TrakPro™ software to setup the Alarm Setpoints. Select

Instrument Setup -> Parameters -> Alarm Setpoint... to get to the
alarm settings dialog.

36

wistrument Setup | Options  Help

Communications...

Radic Comm...

Just Trak DRX

Parameters

Legging Setup...
Legging Control

Clock...
Loegging Intervals...

Time Constants...

_ ] Other...
Calibration...
Analog Output...
8333104202 | Alarm Setpoint...
QR A4S0
e
s . ===

Select program to edit alarm settings
| Alarm Settings
| Alarm Setpoint (ma/m3): 150,000
I Audible oM @ OFF
| Relay © ON @ OFF

Visible oM @ oFF
- T on e

NOTE

below on STEL.

The Alarm is dependent on the logging interval. For the
DustTrak™ Environmental Monitor to alarm as soon as the
Alarm Setpoint is exceeded, the logging interval must be set
as low as possible (i.e., 1 second or 2 seconds). If a long test
duration does not permit setting such a short logging interval,
use the STEL alarm instead. The STEL is always based on

1 second concentrations and is independent of the logging
interval. For more details on the STEL alarm, see section

In Survey mode, the alarm is dependent on the time constant.
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Alarms can be set of each mass channel for the DRX Models 8543/
8543-M (PM1, PM2, Resp, PM1o and Total). Alarms can only be set
for the Total channel for the standard DustTrak™ Models 8540/

8540-M /8542-M.

Alarm Setpoint
[mg/m?]

The alarm setpoint is the mass
concentration level upon which the alarml1
is triggered.

Alarm will trigger if the mass concentration,
taken at the logging interval, rises above
the setpoint.

Relay [On, Off]

When the relay alarm is turned on, unit will
close its local relay switch when Alarm level
is surpassed.

Relay alarm can only be linked to one mass
channel at a time for the DRX models 8543/
8543-M.

STEL [On, Off]

When the STEL alarm is turned on, STEL
data will be collected when Alarm level
is surpassed.

STEL alarm can only be linked to one mass
channel at a time for the DRX models 8543/
8543-M.

See following STEL Note.

Audible [On, Off]

When the audible alarm is turned on, the
instrument will activate internal beeper
when the alarm level is surpassed.

Audible alarm can only be linked to one
mass channel at a time for the DRX models
8543/8543-M.

Visible [On, Off]

Not used for the 8540/8540-M /8542-M /
8543/8543-M models.
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STEL Alarm

STEL stands for Short Term Exposure Limit. When a STEL alarm is
selected, the instrument will inspect the data on a second by second
basis, independent from the selected logging interval. If the mass
exceeds the STEL limit, a STEL event triggers and the following

actions will be taken.

Data

Data will be taken of the STEL alarm channel
at a 1 minute logging interval for 15 minutes.

This data will be stored in a separate file
named STEL_XXX, where XXX will be
matched to the logged data file.

The instrument will also continue to log the
mass concentration data at the logging
interval selected.

STEL Alarm repeat

If the instrument remains over the STEL limit
after the 15 minute interval, or if the
instrument exceeds the STEL limit later
during the sample period, additional STEL
files will be generated.

STEL Data can be downloaded in TrakPro™ software similar to the

standard data.
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Chapter 5

Maintenance

The DustTrak™ Environmental Monitor can be maintained in the field
using the instructions below.

TSI® recommends the DustTrak™ Environmental Monitor be returned
to the factory for annual calibration. For a reasonable fee, TSI® will
quickly clean and calibrate the unit and return it to you in “as new”
working condition, along with a Certificate of Calibration. This “annual
checkup” helps ensure that the instrument is always in good
operating condition.

WARNING

The only user-serviceable parts inside the DustTrak™
Environmental Monitor are the gravimetric filter, pump,
and sheath flow filter accessible behind the removable
service panel.

The instrument case should only be opened by TSI®
or a TSI® approved service technician.

To maintain the MCERTS certification, it is required that the
MCERTS model photometers (8540-M, 8542-M, 8543-M) be
recalibrated on a yearly cycle.

Maintenance Schedule

The DustTrak™ Environmental Monitor requires maintenance
on a regular basis. Table 1 lists the factory recommended
maintenance schedule.

Some maintenance items are required each time the DustTrak™
monitor is used or on an annual basis. Other items are scheduled
according to how much aerosol is drawn through the instrument. For
example, TSI® recommends cleaning the inlet sample tube after

350 hours of sampling a 1 mg/m? concentration of aerosol. This
recommendation should be pro-rated according to how the instrument
is used. 350 hours at 1 mg/m? is the same amount of aerosol as

700 hours at 0.5 mg/m?® or 175 hours at 2 mg/m?, etc.
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Table 1. Recommended Maintenance Schedule

Iltem | Frequency

Clean the inlet nozzle* 350 hr. at 1 mg/m3
Replace internal HEPA filter Every 6 months
Return to factory for cleaning and calibration Annually

Remove and clean the 37-mm blank cassette Monthly

(see Replacing Internal 37-mm Sampling

Cassette section for futher details)

*Pro-rated, see discussion above.

The DustTrak™ Environmental Monitor keeps track of the accumulated
amount of aerosol drawn through it since its last cleaning.

Cleaning the Inlet
The inlet should be cleaned based on the schedule in Table 1.

1. Turn the DustTrak™ monitor off.
2. Remove the 4 screws and the inlet mounting ring.

3. Unscrew the black inlet nozzle from the instrument (Figure 17).

,\Inlet

Nozzle

Figure 17: Unscrew Inlet Nozzle

4. Use a cotton swab to clean the outside of the inlet nozzle body.
You may dampen the swabs with water or a light solvent (e.g.,
isopropanol). Clean the inner diameter of the nozzle by using a
small brush, along with a light solvent. Dry the nozzle by blowing
it out with compressed air, or let it air-dry thoroughly.
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Be careful not to blow particles into the DustTrak™
monitor inlet port.

Figure 18: DO NOT Blow into Instrument

5. Screw (hand-tighten) inlet nozzle back into instrument.

Maintenance
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Cleaning and Oiling Impactors

Follow the recommended Impactor cleaning interval for size selective
Impactors as shown below. These impactors are used with models
8540, 8540-M, and 8542-M DustTrak™ Environmental instruments.

Recommended impactor maintenance interval is every two months
except where the “average dust concentration” level indicated in the
table shows the impactor should be cleaned more frequently:

Average dust Impactor
concentration (mg/m?) maintenance interval
0.015 97 days
0.025 60 days
0.035 42 days
0.050 30 days
0.100 16 days
0.150 10 days
0.250 6 days
0.400 4 days

1. Unscrew Impactor. Check O-ring on the impactor base.

2. Clean outside and inside of Impactor and the impactor plate using
a clean brush and a light solvent. Dry impactor parts by blowing it
out with compressed air, or let it air-dry thoroughly.

3. Apply two drops of oil (included) to the impactor plate. DO NOT
over-fill impaction plate.

Apply
2 Drops of Ol

TR

Figure 19: Apply Two Drops of Oil to Impactor Plate

4. Screw (hand-tighten) impactor back together.
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Replacing the Internal Sheath Air (HEPA) Filter

TSI® recommends replacing the
internal sheath air filter after
every six months of use.

1. Turn the instrument off.

2. Open Instrument Service
Panel (Figure 20).

3. Disconnect and remove old
sheath air filter from the
instrument (Figure 21).

Figure 20: Open instrument
service panel

Figure 21: Disconnect and remove old sheath air filter
4. Replace with new filter (PN B o e L pa
854044). Ensure tubing
coming from the “Y”
connects to the inlet side of
the filter as indicated by the
Flow arrow (Figure 22).

Figure 22: Replace with new filter
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5. Replace cover and return to

44

service (Figure 23).

It is important to reset the
instruments filter change
date and cumulative filter
mass concentration after

replacing the Sheath air
filter. Resetting the filter

concentration may clear the
filter error condition shown in
the Data tab of DustTrak™

Checkout Software. Reset

the date and concentration
by performing the following:

a.
b.

Power the instrument.
Open the DustTrak™ Checkout software.
Connect the provided USB cable to the instrument and your

personal computer.

& Environmental DustTrak Checkout 2!

Connect | Data l Flow

Serial Number:
Model Number:
Firmware Version:
Instrument Time:
Calibration Date:
Filter Change Date:
Cum Mass:

Cum Filter Mass:
Pump Run Time:

Click Connect.

InstiPaddr:  169.254.188.53

000

Click Reset Filter Date and Concentrations.

Figure 23: Replace cover

Zero 1 Laser | Diagnostics l IP Label l IP Addressing

8542164901

8542-M

37

12/14/2017 1:35:40 PM
3/24/2017

12/14/2017

1.602118 mg

0 mg

3111

hrs

Disconnect I

[ Set Instrument Date and Time j

Reset Filter Date and Concentrations

| Shutdown Instrument I
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f. A Dialog box will appear confirming that you would like to
reset the change date and the cumulative filter concentration.
Click Yes to reset the cumulative filter concentration to zero.
The Checkout Software will now show zero for the Cum
Filter Mass and the current date for the Filter Change Date.

Env DustTrak Checkout £

Are you sure you want to reset the filter change date and clear the cumulative
concentrations?

g. The Checkout software will now show, zero for the Cum
Filter Mass Concentration and the current date for the Filter
Change Date.

Replacing Pump

If the pump stops working
it can be removed and
replaced in the field. See
Quick Start Guide included
with Replacement Pump
(854043) for additional
details (Figure 24).

First remove Photometer
from the Environmental
Enclosure following the
applicable steps:

Figure 24: Replacement pump (854043)

1. Disconnect all cabling
from photometer.

2. Remove inlet column. If inlet column includes a heated inlet,
remove ferrite from the heated inlet cable and carefully pull the
heated inlet cable through the key hole on the mounting ring
when removing the inlet column (Figure 25a).

3. Loosen retainer ring on top of enclosure while holding photometer
(Figure 25b).
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4. Pull photometer down and out of enclosure.

Figure 25: (a) Heated inlet cable;
(b) remove retainer ring and lower photometer

5. Have a replacement pump
(P/N 854043) available.

6. Open instrument service
panel (Figure 26).

#5 4

Figure 26: Open instrument
service panel
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7. Remove the four Phillips
head screws from the left-
side panel (Figure 27).

Remove only the raised-head
screws. DO NOT remove any
screws with heads flush to
the surface.

Figure 27: Remove screws from
left side panel

8. Pull the pump from the enclosure and detach tubing, muffler,
and cable.

-~

Figure 28: Pull pump from enclosure and
detach tubing, muffler, and cable

9. Attach the muffler to P,
tubing to V, and cable to the
new pump (Figure 29).

Figure 29: Attach muffler
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10. Orientate pump inside
instrument with muffler
(port P) located in the lower
position (Figure 30).

11. Secure the new pump inside
the instrument case with the
four Phillips head screws
(Figure 31).

12. Replace photometer service
panel and reinstall
photometer inside
Environmental Enclosure
following the steps above in
reverse order.

Figure 31: Secure new pump

Replacing Internal 37-mm Sampling Cassette

The internal 37-mm sampling cassette can be used to conduct
sampling for gravimetric or analytical analysis. The instrument
comes with a blank cassette containing a mesh sieve to keep large
particulate out of the instrument pump. Save this cassette and the
filter. The DustTrak™ Environmental Monitor is designed to have
this cassette in place. The flow path will be compromised without
this cassette.

On occasion, this cassette should be removed and the mesh screen
cleaned by blowing with compressed air or rinsing under running
water and allowing the filter to dry before replacing the cassette. The
maintenance interval will vary depending on the aerosol concentration
being sampled. TSI® recommends initially checking this screen
monthly until the accumulation rate is understood. The screen should
be changed out before it is completely coated with aerosol buildup.

48 Chapter 5



TSI® does not provide the filter media for gravimetric or analytical
sampling. When requesting cassette with filter media for gravimetric
sampling, ask for a 37-mm, 2-piece, static conductive plastic cassette
to ensure proper fit inside the DustTrak™ monitor.

1. Toremove cassette, open instrument service panel to access the
sampling cassette. Internal sampling cassette is located in the
upper right opening.

TN
e — 24V I3W

Figure 32: Remove sampling cassette

2. Pinch the blue clip to release the bottom cassette holder and
remove cassette from the holder.

= :/‘-‘J\y .13\‘-&‘/ St » L =) 2_,}\!/ '13\W L :

£7 "
Figure 33: Release and remove cassette holder
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3.

Inspect top inlet fitting
and blue cassette
holder for broken
pieces or missing seals
(Figure 34).

Install a blank cassette
for DustTrak™ monitor
operation or a pre-
weighed, 37-mm,
2-piece, conductive
cassette with the
appropriate filter
media for the analysis
to be performed.

AL -

Figure 34: Inspect top inlet fitting and
blue cassette holder

Make sure the Cassette snaps securely into the inlet port on the
top of the cassette holder and the bottom clip snaps securely into
place. If the connection is loose, air will leak resulting in
inaccurate sampling results (Figure 35).
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Figure 35: Snap cassette securely into inlet port
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Return Shipping to TSI® Incorporated

Visit our website at tsi.com/service to initiate a Service Request form:

Disconnect and remove all accessories. Only the photometer can
be serviced.

The model number can be found on the label on the back of the
instrument. The model number will be needed for the Service
Request form.

o For 8540-M use 8540

o [For 8543-M use 8543

Package the instrument in the original shipping container.

If original shipping container is not available, pack instrument
securely in a durable shipping carton to prevent damage during
shipment. Consult with courier for packing guidance.

Include printed copy of Service Request form inside container
with instrument.

Ship to TSI® via trackable shipping method.
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Chapter 6

Troubleshooting

The table below lists the symptoms, possible causes, and
recommended solutions for common problems encountered with
the DustTrak™ monitor.

Symptom
Erratic reading.

| Possible Cause

Leak

| Corrective Action

Check connections
for leaks

Dirty inlet port and/or
sample tube

Clean inlet port. Clean or
replace tubing

Internal filter(s) not
installed properly

Inspect internal filter
wells to make certain

(leaking) the filters and O-rings

are seated properly.
Replace internal filters
if necessary

DustTrak Zero Drift Increase autozero

reading frequency

negative

concentrations

Analog output
does not work

Cable/connector not
correctly installed

Make sure cable
connector is fully seated

Output wired with
reverse polarity

Make sure analog out (+)
and analog ground (-)
are wired correctly to
data-logger

Alarm output

Alarm function not

Turn the alarm function

does not work turned on on in TrakPro™ software
Alarm does not | Alarm setting Check the alarm settings
turn on correctly | incorrect in TrakPro™ software

Alarm output wired
with reverse polarity

Alarm wires are
polarized. Voltage input
must be wired to alarm
input (+)




Symptom
Instrument does

not store new
data

| Possible Cause
Memory is full

| Corrective Action

Delete or transfer
historic data

Instrument is in
Survey mode

The instrument does not
store data in survey
mode. Can to manual or
program log mode

Flow Error is
indicated in
Data set or on
Environet

Flow obstruction

Remove obstruction if
still present. Press any
key to bypass

Internal pump failing,
indicated by inability
to adjust flow rate to
full range

Replace pump per
instructions in
maintenance section

37-mm cassette
clogged or has mass
loading

Replace the filter
cassette. See the
maintenance section of
the manual

Laser Error
indicated in data

Laser background is
too high

Remove and clean inlet
nozzle. Pay close

set of on attention to the tip of the

Environet nozzle that is inserted
into the instrument to
ensure it is clear of any
contamination

Laser is failing Factory service may

be required

Filter Error Internal sheath air Replaced the filter per

indicated in data | (HEPA) filter needs to | instructions in the

set or on be replaced maintenance section of

Environet this manual. Make sure

to reset the filter mass
and date once the filters
have been changed

NOTE

This is only a warning. The unit will continue to operate normally until
the increase in pressure drop across the filter is so high that the
pump can no longer maintain the set flow rate.
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Appendix A

Specifications

Specifications are subject to change without notice.

8540/8540-M /8542-M /8543 /8543-M DustTrak™ Environmental
Monitors are designed to operate inside a weather-proof enclosure,
like TSI® Model 854038 Environmental Enclosure, sold separately.

Sensor Type ........... 90° light scattering
Range.......ccoeceeueeuen. 0.001 to 400 mg/m® (models 8540,
8540-M, & 8542-M)

0.001 to 150 mg/m® (models 8543 &
8543-M)

Resolution .............. +0.1% of reading or 0.001 mg/m?,
whichever is greater

Zero Stability .......... +0.002 mg/m? 24 hours at 10 sec
time constant

Particle Size

Range......cccccceeenns Approximately 0.1 to 10 um (8540,
8540-M, 8542-M) / 0.1 to 15 um (8543,
8543-M)

Flow Rate................ 3.0 L/min set at factory

Flow Accuracy........ +5% factory setpoint
Internal flow controlled

Temperature

Coefficient .............. +0.001 mg/m? per °C

Operational Temp .. | 0°to 50°C

Storage Temp ......... -20° to 60°C

Operational

Humidity.........c.c..... 0-95% RH, non-condensing

Time Constant ........ Adjustable 1 to 60 seconds

Data Logging........... 45 days at 1 minute samples

Log Interval............. 1 second to 1 hour
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Physical Size

(HWD) ..cveveiieeiee 8.25x 8.25 x 4.25 in.
(20.96 x 20.96 x 10.80 cm)
Weight ... 5.25 Ibs (2.38 kg)

Cellular, Wi-Fi®, GPS/GPRS, USB
(Host and Device) and Ethernet.

12/24 Volts DC
50 Watts

8540/8540-M /8542-M /8543 /8543-M:
User selectable output 0 to 5 V or 4 to
20 mA

User selectable scaling

8540/8540-M /8542-M /8543 /8543-M:
Relay or sound buzzer
Relay

No latching MOSFET

User selectable setpoint

5% deadband

Connector 4-pin, Mini-DIN connectors

Internal Sampling
Cassette .................

Removable 37-mm, 2-piece, static
conductive cassette.

Contact AIHA Accredited Analytical Lab for
guidance on selecting the proper filter
media for your desired analytical testing.

®Wi-Fiis a registered trademark of Wi-Fi Alliance.
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Appendix B

Instrument Command Set

See the DustTrak™ Communication Manual for instrument command
instructions for communicating with wireless modems and other
dataloggers. Contact TSI® for a copy of the communication manual
(P/N 6002481).

Connecting to the Instrument

USB and Ethernet instrument connections use the NDIS
communication method, port 3602.

NIDS Communication Method

This method communicates with the instruments via USB and
Ethernet connections. This method uses windows sockets.

W 5y R AR A R AT

. Shenzhen Things Test Techonology CO.,LTD
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Appendix C

DRX Advanced Calibration

The advanced calibration method is employed to yield high size
segregated mass concentration accuracy for PM, o, PM, 5,
Respirable, and PMy, size fractions. It involves two gravimetric
measurements to obtain PCF and SCF. The two gravimetric
measurements can be done in sequence or in parallel, depending on
the gravimetric sampling device availability.

Option 1: Serial Gravimetric Calibration

When you have only one set of gravimetric sampling devices, the
DustTrak™ DRX advanced calibration can be performed in two serial
steps. The experimental setup is in Figure 36a. The calibration steps
are outlined below:

Step 1: PCF Calibration

e Install a PM, 5 impactor at the inlet of the external
gravimetric filter.

e Co-locate and run the gravimetric sample and DustTrak™
DRX monitor simultaneously to collect enough mass on the
gravimetric filter.

e Calculate the PM, 5 mass concentration (PM; 5 gray) from the
gravimetric filter based on the net mass collected on the filter,
sampling time, flow rate, and total liters of air sampled.

e Read the DustTrak™ DRX monitor average PM, 5 mass
concentration (PM, 5 prx) from the screen or through
TrakPro™ Data Analysis Software.

e Calculate the new PCF

M2.5_Grav

PO N ™M, 5 orex

xPCF 4.
e Update the new PCF in user calibration settings.

Step 2: SCF Calibration

o Install a PMyq impactor at the inlet of the external
gravimetric filter.
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e Co-locate and run the gravimetric sample and DustTrak™
DRX monitor simultaneously to collect enough mass on the
gravimetric filter.

e Calculate the PM4o mass concentration (PMyq_gray) from the
gravimetric filter based on the net mass collected on the filter,
sampling time, flow rate, and total liters of air sampled.

e Read the DustTrak™ DRX monitor average PM, 5 (PM2 5 prx)
and PMyo (PMy_prx) mass concentration from the screen or
though TrakPro™ Data Analysis Software.

e Calculate the new SCF

-

I:>M‘1O_Grav - PMZ.S_DRX

3
SCFNew: < > XSCFO|d.

PM1o prx — PM2.5 prx

e Update the new SCF in user calibration settings.

Option 2: Parallel Gravimetric Calibration

When you have two sets of gravimetric sampling devices, the
DustTrak™ DRX monitor advanced calibration can be performed in
the parallel configuration as shown in Figure 36b. The calibration
steps are outlined below:

1. Install a PM, 5 and a PM,, impactor at the inlet of the two external
gravimetric filters, respectively.

2. Co-locate and run the gravimetric samples and DustTrak™
DRX monitor simultaneously to collect enough mass on the
gravimetric filters.

3. Calculate the PM, 5 (PMy s gray) @nd PMqg (PM1g_gray) Mmass
concentrations from the gravimetric filters based on the net mass
collected on the filter, sampling time, flow rate, and total liters of
air sampled.

4. Read the DustTrak™ DRX monitor average PM, 5 and PM,q
mass concentration (PM; 5 prx and PMyg prx) from the DRX
screen or through TrakPro™ Data Analysis Software.

5. Calculate the new PCF

F,M2.5_Grav

PCFNeW= PM XPCFO|d ,

2.5 DRX
and the new SCF

Wl =

I:)M1O_Grav - PMZ.S_Grav) xSCF
Old-

SCFew= (PMm_DRx ~PMas omx
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6. Update the new SCF and PCF in the user calibration settings.

Aerosol Source

First PM.s Impactor
then PM4, Impactor

DUSTTRAK DRX
————————— Filter

To Flow Control
and Vacuum

Aerosol Source

l

PM1o PMZ.S
Impactor Impactor

DuUsTTRAK DRX
_________ Filter [-------1Filter

' l

To Flow Control To Flow Control
and Vacuum and Vacuum

Figure 36: Experimental Setup for
(a) Serial and (b) Parallel Gravimetric Calibration

|| Bl e o

- Shenzhen Things Test Techonolagy CO.,LTD

DRX Advanced Calibration

(@)

(b)
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